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WEEK  1    Practical 

Objectives: 

• The student is expected to get familiar with the SSADM package that will allow him to 
run  the various  practicals 

• Other methodologies will also be briefly discussed 
• The meaning of  SSADM, its techniques, logical modeling, data flow modeling, Entity 

/Event modeling 
• Structure of SSADM 

Introduction 

In the early days of large scale information systems development many organisations used the 
Cobol programming language together with indexed sequential files to build systems for 
customer billing, payroll, stock control and a variety of other business areas. Developments at 
this time were characterised by :- 

• limited user involvement;  
• inadequate requirements elicitation;  
• use of ad hoc analysis and design techniques;  
• absence of CASE support for analysis and design;  
• time consuming use of 3GL tools;  
• inflexible file and 3rd generation database management systems.  

Frequently the results of this approach were systems which, on delivery, did not satisfy business 
requirements. This caused extensive maintenance requirements and thus an increase in the 
applications backlog. A variety of problems may have caused the mis-match between system 
functionality and business requirements :- 

• a lack of ownership of and commitment to the system from users as a result of the low 
level of involvement;  

• business requirements may have changed between inception and delivery;  
• requirements may have been mis-understood;  
• inadequate analysis and design tools and techniques may have been used;  
• or more likely a combination of these problems.  

 The response from the information systems community to these problems was the development 
of structured methodologies for ISE. The purpose of these methodologies seems to have been to 
(a) formalise the requirements elicitation process to reduce the chances of mis-understanding the 
requirements  

 (b) To introduce best practice techniques to the analysis and design process 
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 SSADM (in common with other structured methodologies) adopts a prescriptive approach to 
information systems development in that it specifies in advance the modules, stages and tasks 
which have to be carried out, the deliverables to be produced and furthermore the techniques 
used to produce the deliverables. SSADM adopts the Waterfall model of systems 
development,(this will be discussed later in other courses) where each phase has to be completed 
and signed off before subsequent phases can begin. SSADM is one example of a structured 
methodologies, a variety of others are widely used in ISE, including : 

STRADIS: (Structured Analysis, Design and Implementation of Information Systems) a 
methodology developed by Gane and Sarson (1979). The methodology is based on the 
philosophy of top down functional decomposition and relies on the use of Data Flow Diagrams. 

YSM: (Yourdon Systems Method,Yourdon, 1993). YSM is similar to STRADIS in its use of 
functional decomposition, however a middle-out approach is dopted and slightly more emphasis 
is placed on the importance of data structures. 

MERISE: (Quang and Chartier-Kastler, 1991)The methodology is widely used in ISE in France, 
Spain and Switzerland. MERISE consists of three ‘cycles’, the decision cycle, the life cycle and 
the abstraction cycle. The abstraction cycle is the key, in this cycle both data and processes are 
viewed firstly at the conceptual level, then the logical or organisational level and finally at the 
physical or operational level. 

EUROMETHOD: (CCTA, 1994) Euromethod could be described as a framework for the 
integration of existing european methodologies rather than as a methodology in its own right. 

 What is SSADM? 

SSADM (Structured Systems Analysis and Design Methodology) is a methodology ( i.e a system 
of ways of doing things especially regular and orderly procedures), used in the analysis and 
design stages of systems development. SSADM does not cover SITP issues or the construction, 
testing and implementation of software. 

"SSADM has been used by  in computing since its launch in 1981. In a bid to standardise the 
many and varied IT projects being developed . Since 1981 SSADM has been further refined and 
version 4 was launched in 1990. SSADM is an open standard, i.e. it is freely available for use in 
industry and many companies offer support, training and Case tools for it. 

Why is SSADM Used?  

Within government departments SSADM has to be used. External contractors producing 
software for the government also have to use SSADM. SSADM is used by other companies 
because they expect the use of a disciplined ‘engineering approach will eventually improve the 
quality of the systems they produce. many companies have been willing to incur the considerable 
expense of implementing SSADM (e.g. staff training) with this expectation in mind. 
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Major Tools of SSADM? 

SSADM revolves around the use of three key techniques, namely  

• Logical Data Modeling,  
• Data Flow Modeling   
• Entity/Event Modeling. 

� Logical Data Modeling;    This is the process of identifying, modeling and 
documenting the data requirements of a business information system. A Logical 
Data Model consists of a Logical Data Structure (LDS - The SSADM terminology 
for an Entity-Relationship Model) and the associated documentation. LDS s 
represent Entities (things about which a business needs to record information) and 
Relationships (necessary associations between entities) 

� Data Flow Modeling;   This is the process of identifying, modeling and 
documenting how data flows around a business information system. A Data Flow 
Model consists of a set of integrated Data Flow Diagrams supported by 
appropriate documentation. DFDs represent processes (activities which transform 
data from one form to another), data stores (holding areas for data), external 
entities (things which send data into a system or receive data from a system and 
finally data flows (routes by which data can flow)  

� Entity Event Modeling; This is the process of identifying, modeling and 
documenting the business events which affect each entity and the sequence in 
which these events occur. An Entity/Event Model consists of a set of Entity Life 
Histories (one for each entity) and appropriate supporting documentation. slide 9  

   

   Structure of  SSADM  

SSADM consists of 5 main modules, which are in turn broken down into a complex hierarchy of 
stages, steps and tasks. slide 11  

1. Feasibility Study;   Module 1 the feasibility study consists of a single stage (Stage 0 
Feasibility),which involves conducting a high level analysis of a business area to 
determine whether a system can cost effectively support the business requirements. In 
stage 0 an overview DFD is produced together with a high level LDS. At this stage the 
DFD will represent the existing system warts and all and the LDS may be incomplete and 
contain unresolved M:M relationships.  

 

2. Requirements Analysis;      Module 2 requirements analysis consists of 2 stages;  
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� Stage 1 Investigation of Current Environment and Stage  
�  Business System Options (BSO).  

 
 
During stage 1 the systems requirements are identified and the current business 
environment is modeled in terms of the processes carried out and the data 
structures involved.  During stage 1 DFDs and an LDS are used to produce 
detailed logical models of the current system .  During stage 2 up to 6 business 
system options are produced and presented. As a result one of these options (or 
indeed a hybrid solution) is adopted and refined. During stage 2 DFDs and LDS 
are produced to support each business system option and the final chosen option. 
The transition from stage 1 to stage 2 is a key part of SSADM, this is where we 
move from a logical model of the current system to a logical model of the 
required system, i.e. this is where the DFDs and LDS have to be refined to cater 
new/changed requirements. 

3. Requirements Specification;   Module 3 Requirements Specification consists of a single 
stage (Stage 3 Definition of Requirements) which involves further developing the work 
carried out in module 2, detailed functional and non-functional requirements are 
identified and new techniques are introduced to define the required processing and data 
structures. In stage 3 the DFDs and LDS are refined and cross validated in the light of the 
chosen business system option. The LDS is enhanced using relational data analysis 
(normalisation). The DFDs and LDS are validated against the ELHs also produced during 
this stage. DFDs LDS and ELHs are used as input to the subsequent stages of SSADM. 

 

4. Logical System Specification;  Module 4 Logical System Specification consists of 2 
stages; Stage 4 Technical System Options and Stage 5 Logical Design. In stage 4 up to 6 
technical options (specifying the development and implementation environments) are 
produced, one being selected. In stage 5 the logical design of update and enquiry 
processing and system dialogues (menus etc.) is carried out.  

 

5. Physical Design;  Module 5 Physical Design consists of a single stage (Stage 6 Physical 
Design) in which the logical system specification and technical system specification are 
used to create a physical database design and a set of program specifications.  
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WEEK   2   Practicals 

This Practical introduces the student to the tutorial sheet of SSADM 

Questions are asked and the student is advised to attempt them. 

Tutorial Sheet: Introduction to SSADM 

Objectives 

The objective is to encourage you to view SSADM not as a magic pill which can be swallowed 
whole or not at all, but as an analysis & design framework or set of tools which can be adopted 
in whole or in part depending on requirements and which can be modified, tweaked or 
manipulated by people with sufficient experience and expertise. 

Question 1 

Of the three main tools of SSADM (LDS, DFD, ELH) which is the most important and why 
from the point of view of the analyst/designer? Which would be the easiest to understand from 
the end-users point of view? 

Question 2 

"When developing information systems the technical environment should be established as soon 
as possible to avoid any nasty surprises in the later stages of development." Is this a valid 
statement? If so why within SSADM do technical system options not get considered until the 
penultimate module. 

Question 3 

With so many possible implementation environments is there any point having a general physical 
design module? 

Question 4 

Why do you suppose ELHs are not used alongside the DFDs and LDS in the requirements 
analysis phase? 

Question 5 
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Would SSADM be feasible without the support of CASE tools? 

 

 

WEEK  3  Practical 

Students are introduced here to a basic software that will allow them to create, design and 
implement various kind of system analysis diagrams using Eldraw Max software 

Introduction 

Edraw Max enables students, teachers and business professionals to reliably create and publish 
kinds of diagrams to represent any ideas. It's an all-in-one graphics software that makes it 
simple to create professional-looking flowcharts, organizational charts, network diagrams, 

business presentations, building plans, mind maps, fashion designs, UML diagrams, 
workflows, program structures, web design diagrams, electrical engineering diagrams, 

directional maps, database diagrams and more. Screenshot  

Create flowcharts, organizational charts, network diagrams with minimum time 

loss!  

With large pre-drawn libraries and more than 4600 vector symbols, drawing couldn't be easier! 
Edraw Max lets you create a wide range of diagrams using templates, shapes, and drawing 

tools while working in an intuitive and familiar Office-style environment.  

Edraw provides you a versatile, easy, quick and professional solution to let you enjoy your 

working.  

Why have we Chosen   Edraw  Max ? 

1. Uses  the diagramming software that best maps to what you know and where you're 

headed.  
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2. Is Fully vector-based graphic software, which facilitates the rapid creation of flowcharts, 

organizational charts, network diagrams and more.  

3. Supports to import the exist Visio XML file perfectly.  

4. Just drag the build-in shapes from the library pane and drop them on your page. Drawing 

couldn't be easier!  

5. Creates professional-looking diagrams quickly with themes, effects and quick styles.  

6. Gains greater productivity in diagramming with features like automatically aligns and 

arranges all shapes.  

7. Includes lots of high-quality shapes, examples and templates.  

8. Distinct colors, fonts, shapes, styles, pictures, text, and symbols are available for each 

diagram object.  

9. Easily visualizes complex information with a wide range of diagrams. Make those 

diagrams even smarter and more useful by linking them to underlying data, which 

provides a more complete picture of the system or process.  

10. Works with MS Office well. It can be integrated with Microsoft Office application easily. 

The UI is MS Office-style like, it's easy to learn and use. If you are familiar with MS 

Office, you are familiar with Edraw quickly.  

11. Generics graphic formats support and WYSIWYG printing.  

Additional Features 

• The UI is MS Office 2007 style like. Full ribbon features.  

• Added Themes, Color Themes, Effects and Fonts. Easy to change the whole diagram by 

changing the active theme. With the new Theme feature, you can format the colors and 

effects in an entire diagram with a single click.  

• Real-time previews. When you scroll over the various galleries in Edraw, you'll see your 

drawings and various objects change to display what they'll look like if you decide to 

apply those settings. Just click on the thumbnail in the gallery to actually accept the 

changes. This makes it a lot faster to see, for example, how changing a color scheme will 

affect your drawings.  

• Quick layouts and quick styles. These provide quick formatting options for the object in 

question, and make it easy to create good-looking slides with just a few clicks.  
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• Put Edraw graphics into Word, Excel, PowerPoint with one-click buttons.  

• Text objects supported line space, bullet, Indent, back color, super script, sub script and 

more.  

• Shadows in general are so very nice compared to those in previous versions. We can 

actually control the transparency, amount of blur, and color now.  

• Shape and text presets make it really easy to apply a preset look to an object or text.  

• It's quicker to zoom in and out now using the zoom slider in the southeast corner of the 

screen.  

• Table support.  

• Recolor picture, Light and Contrast, transparent PNG support.  

• Opened the Shape Sheet for senior users to create more complicated shapes.  

• More 2000 clip arts.  

• Improved the Insert Hyperlink function.  

• Improved the Print function. Support more page sizes such as A0, A1. You can also print 

the large size graphics in separate pages.  

• Persistent undo and redo.  

• High quality graphic export.  

Vector-based 

Edraw Max is a vector-based diagramming software, which means whatever size you change the 

diagram, it will always keep high quality.  

Easy and friendly UI 

Edraw UI is MS Office-style like, it's easy to learn and use. If you are familiar with MS Office, 

you are familiar with Edraw quickly.  

Work with MS Office well 

Edraw provides several ways to cooperate with MS Office system.  

You can copy the selected shapes then paste it into MS Office document.  
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You can insert the Edraw OLE object in MS Office application.  

You also can export the drawings to generics graphic formats such as jpg, tif, bmp. Then switch 

to MS Office and insert the picture.  

Support almost all kinds of graphics formats 

Supports almost all the generics graphics formats, it can export or import those common graphics 

formats, like bmp, gif, dib, png, tif, wmf, emf, html and so on.  

Save as exe file and share it with anyone without Edraw  

You can save your drawing file to exe format and share it with anyone you want, even it has no 

Edraw installed.  

Provide drawing tools like Illustrator 

Provides a set of drawing tools like Adobe Illustrator, with those tools you can draw your own 

shapes or change the shapes in library.  

Distribute shapes automatically  

Edraw can help you align and arrange all shapes automatically, this will speed your working.  

Strong style system and plenty of beautiful build-in styles  

Edraw has an easy and quick style system, and provides a lot of pre-defined styles, which can 

help you make your diagram beautiful and personal in short time.  

Abundant libraries and templates involving kinds of fields  

Provide abundant libraries and templates include flowcharts, organizational charts, build plans, 

network diagrams and more.  

Define and manage your own libraries and templates 
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You can draw your own shapes and documents save as libraries and templates, and use them as 

pre-defined libraries and templates.  

Edraw System requirements 

• Windows® 2000, Windows® XP Tablet PC, Windows® XP, Windows 2003, Windows 

Vista  

• 256 MB of RAM, 20 MB of hard disk space  

• Pentium® III, 750MHz processor  

• 1,024 x 768 or better monitor resolution  

• Mouse and keyboard  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

WEEK  4    Practical 

 

After few explanations by the teacher, t
flow charts: 

 

Perfect Flowchart Examples!

 

Basic Flowchart 

Data Flow Diagram 

 

 

After few explanations by the teacher, the student is required to understand the following 

Perfect Flowchart Examples! 

 

Business Process Diagram Network Diagram

 

 

Work Flow  Business Chart
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he student is required to understand the following 

 

Network Diagram  

 

Business Chart 
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Planning Diagram Sales Flowchart Cause & Effect Diagram 

Here the student is expected to practice the following: 

 

Fig.  Sum of first 50 natural numbers  
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Flow Chart Example 2  

Draw a flowchart to find the largest of three numbers A, B, and C.  

Answer: The required flowchart is shown in Fig 2  

 

Fig : Flowchart for finding out the largest of three number  
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Flowchart Example 3  

Draw a flowchart for computing factorial N (N!)  

Where N! = 1?2?3?....N .  

The required flowchart has been shown in fig 3  

Answer:  

 

Fig 3 Flowchart for computing factorial N  
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WEEK 5  Practicals 

In continuation of the flow chart familiarization and drawing, the student is expected to 
practice the following:  

Understand the problem below and try to design a flow chart for it 

 

A product assembly team in a gaming machine manufacturer were looking for ways of building 
the product more efficiently. They broke down the assembly process into a set of Flowcharts, 
showing how sub-assemblies were made and then built into the final product. Analysis of the reel 
assembly process revealed two improvements:  

1. The kit of parts was already checked by the kit assembly line, who were sometimes 
careless, as they knew the kit would be rechecked. The assembly line process was 
improved so the check here could be removed. This saved over two minutes per reel in 
checking, and up to fifteen minutes when the kit was faulty.  

2. Fitting the reel band after the reel had been attached to the base was awkward. Fitting the 
band before the reel was attached to the base was more comfortable and saved about a 
minute per reel.  

Draw the process Flowcharts, before and after improvement 

This flow chart is shown below and must be practiced by the students  
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Fig    Flowchart for gaming machine manufacturer  

 

 

WEEK  6 – 8  PRACTICALS 

The student is expected to study and understand the following example of an Organisational 
Chart and attempt the tutorial thereafter. 

Example of Organizational Chart 

Recommend a new flowchart software similar to Visio, Support flowcharts, organizational 

charts, business charts, UML diagrams, database & ERD, directional map and network diagrams. 

Easy-to-use drawing tools, many pre-drawn flowchart templates, more than 2000 symbols and 

examples, create flowcharts and business diagrams with minimum time loss.  

How to make an organizational chart? How indeed does one go about it, without seeing and 

example of organizational charts? Except one has a good example of an organization chart it 

may be difficult to grab it. 

With Edraw Organizational Chart , you can create clear and comprehensive organizational 

charts with no prior experience. As you can see by studying the examples of organizational chart 
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below, these types of charts are the ideal way to illustrate the inner structure and hierarchy of a 

business or any other type of organization.  

Nothing is left unclear when structural relationships are illustrated with an organizational chart 

created with Edraw - the ultimate organizational chart software. Use it to create Organizational 

charts, visualize company organizational chart, business organizational chart, bank 

organizational chart, corporate organizational chart school organizational chart and government 

organizational chart simples etc.  

                       

 

 

 

 

 

 

 

 

 

 

Perfect Organizational Chart Examples  

  

 

Business Organizational 
Chart  

Photo Organizational Chart 

Company Organization 
Chart  



 

City Organizational Chart

Corporate Organizational 
Chart  

 

 

Financial Organizational 
Chart  

 

  

City Organizational Chart  

Market Organizational 
Chart  

IT Organizational Chart

  

Corporate Organizational Human Resource Org Chart School Organizational 
Chart

  

Financial Organizational Team Organizational Chart 

Police Organizational 
Chart
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IT Organizational Chart  

 

School Organizational 
Chart  

 

Police Organizational 
Chart  
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Hospital Organizational Chart 
 
 
 

Organizational Chart Tutorial  

Using Edraw to Create Organizational Charts  

The tutorial explain how to create organizational charts using Edraw. The easiest way to draw a new organizational 
chart based on the Edraw organization chart templates and examples.  

What does Edraw Organizational Chart do? 

 
Edraw Org Chart is an organizational Chart diagramming program that can help you create business and technical 
diagrams that document and organize complex ideas, processes, and systems.  

Interface  

Edraw's toolbars contain buttons you can use to issue commonly used commands. To find out what each button does, 
float your mouse pointer over (do not click) the button.  

• Edraw Screenshot  
• Organizational Chart Templates  
• Organizational Chart Examples  

 

Creating the Organization Chart  

You can open the organizational chart template for the library menu. It includes Frame Shapes, Card Shapes, Photo 
Shapes, People Shapes and Custom Shapes. Library > Organizational Chart > Frame Shapes 
 

Drag the Executive icon to your chart. After you create the new drawing, create the organization chart by dragging 
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shapes from the stencil to the drawing page. An organization chart shape contains the name and title of the person 
represented by the shape.  

Organization Chart Shapes  

• Single Entries  
• Executive - highest position  
• Manager - box is similar to Executive but smaller, double lines  
• Position - single line box  
• Consultant - box with dashed lines  
• Vacancy - box with dotted lines  
• Assistant - dark single line that typically goes to the right of the Executive or manager box  

 

Adding Multiple Shapes 

 
You can add more than one shape of the same type to your organization chart. For example, you might need five 
Manager shapes under an executive shape. You can insert all the Manager shapes by dragging the Multiple Shapes 
shape over the Executive shape. When you do this, the Add Multiple Shapes dialog box appears in which you specify 
the number and type of shapes to be inserted.  

 

In Edraw, users create org charts by starting at the top and moving to the bottom. So the first shape added usually 
represents an executive. However, the topmost shape could represent a manager or project leader if the user is creating 
an org chart for a single department or team.  

Modify Layout Options   

You can use the follow two toolbars to layout shapes easily. You can also use the automation align function while you 
dragging.  
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Edit Text  

Very many pre-defined shapes have multiple text boxes. You can click the text region to edit every one. You can use 
the "Text Block Tool" to change their position too. See how to edit text.  

Replace Image  

All the images in the Photo Shapes can be replace with a local image file. Firstly select a photo shape then click the 
"Replace Photo" item in the context menu.  

 
 
 
 
 



Page | 25  

 

 

WEEK 9  Practical 

The student is expected  here to  create his own organizational chart shapes and draw them. 

Create your own Organizational Chart Shapes  

Edraw provide some easy to use drawing tools. Include line, arc, curve, freeform, rectangle and ellipse. You can create 
any shapes with these tools. See How to create basic shapes.  

Adding a Fill Color   

First click on the shape you would like to format, making sure that the green formatting handles appear around it. Click 
the Format > Fill Menu. Detail. Or you can use style and color scheme to fill shapes.  

Add the Background  

Drag the pre-defined background into drawing. Library > Basic Shapes > Background  

 

Printing Organization Charts  

 
Edraw is a free printable organization charts software.  

Organizational charts may not always fit neatly onto the standard 81/2 by 11 sheet. File > Page setup  
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Insert Edraw file into Microsoft file  
Open Microsoft Word file. 
Insert > Object 
Select Create from File tab. 
Click Browse button and select the Edraw file. (file has edx extension 

How to Create Organizational Charts 

Organizational charts  

An organizational chart provides a tool for evaluating titles and functions within an organization or business.  

An organization chart (org chart) is a diagram of a reporting hierarchy that is commonly used to show relationships 
among employees, titles, and groups.  

Org charts can range from simple diagrams, as in the following illustration, to large and complex diagrams that are 
based on information from an external data source. The shapes in your org chart can display basic information such as 
name and title, or details such as department and cost center. You can even add pictures to the org chart shapes.  

Create an Organizational Chart 

Open Edraw. When Edraw opens, all you need to work with is the one titled Template Categories. (Tips: If you 
already have Edraw open, on the Edraw Main Button, point to New, and then click Choose Drawing Types....)  

In the Template Categories list, click the Organizational Chart category. All of the libraries in the organizational 
chart category appear in the central window.  

 

Double-click the template titled Photo Organizational Chart.  
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When the Organizational Chart Shapes library opens, most of the space is taken up with a blank drawing page. 
Because it is important to line up the shapes when you create a diagram, the page appears with grid lines on it.  

 

Traditionally, organizational charts were drawn with a template and a ruler. Now, however, the process is made much 
easier with Edraw.  

How to replace photo in the Organizational Chart Shapes 

Including pictures of employees in your organization charts can help to humanize your corporate intranet site, help 
new employees get acquainted, and assist far-flung virtual teams to get a sense of who their co-workers are. Using the 
improved organization chart shapes in Edraw, you can easily add pictures to your organizational charts.  

Right-click the organization chart shape you want to add a picture to, and then click Replace Photo. In the Insert 
Picture dialog box, locate the folder that contains the picture you want to insert, and then click the picture file.  

 

Connect Organizational Charts Shapes with the Smart Connector 



Page | 28  

 

It's easy to connect organizational chart shapes in Edraw. On the Home tab, in the Basic Tools group, click the 
Connector tool. 

To create a smart connector you need to point the cursor at any connection point of the shape. The connection point 
will be highlighted red. 

How to Draw Organizational Charts 

Even as you create an up-to-the-minute organization chart today, you know it will be obsolete tomorrow. But you can 
set up your organization charts so they are fast and easy to revise.  

 

You can also turn organization charts into dynamic communication and management tools by storing data in the 
shapes, such as department or telephone number, or even protected confidential information about employees, such as 
salary or start date, behind the scenes.  

To create an organization chart  

From the Organization Chart Shapes stencil, drag the shape onto the drawing page. Any shapes can be Executive or 
Manager or Staff. Double click to edit the name.  

Link your organizational charts together  

It's easy to add hyperlinks to the shapes and pages in your diagrams. The hyperlinks can go to:  

• Another page in the same Edraw drawing.  
• A page or shape in another Edraw drawing.  
• A document other than a Edraw drawing.  
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• A Web site.  

For network design and documentation, linking a shape or page in one Edraw drawing to a shape or page in another 
Edraw drawing is an ideal way to reduce complexity.  

For network design and documentation, linking a shape or page in one Edraw drawing to a shape or page in another 
Edraw drawing is an ideal way to reduce complexity.  

1. Make sure that both the file you're linking from and the file you're linking to have been saved.  
2. If you're creating a link to a specific shape, make a note of the shape id and the name of the page that the shape 

is on.  
o To find a shape id, click the shape to select it, and then the shape id will appear on the statute bar at 

bottom of the window.  
o To find the page name, locate the tab for the page at the bottom of the drawing window.  

3. Select the shape to add a hyperlink.  
4. On the Insert menu, click Hyperlinks .  
5. In the Address box, click Browse, and navigate to the file you want, and then click Open.  

If you don't see the file you want, try changing the Files of type list.  

6. To link to a specific page or a specific shape on a page, or to choose a zoom level, click Browse next to Sub-
address.  

o Do any of the following:  
� To link to a specific page, select the page name in the Page box.  
� To link to a specific shape, first select the page name on which the shape appears in the Page 

box, and then type the id of the shape in the Shape box.  
� To specify a zoom level, type a percentage in the Zoom box, or click the arrow to select a zoom 

level.  

Note  You can use the zoom level to show more or less detail of the drawing. Use a low number 
to show more detail of a smaller area of the drawing or a high number to show less detail of a 
larger area of the drawing.  

o Click OK .  
7. In the Description box, type a name for the link. This text will appear when the pointer rests over the link in the 

drawing.  
8. To create a Web link, type the web address in Address box.  
9. To add another hyperlink to the page or selected shape, click New, and then repeat steps 5 through 8.  
10. Click OK .  
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Or you can open the Frame Shapes in the Organizational Chart Category.  

 

The design of your organizational chart is dependent on the type of organization. Some organizations are described as 
"flat," meaning that many people report to a single person at the top of the organization. Others are more vertical in 
nature with a few people reporting to the top. In some organizations, departments or organizational units are similar 
in size; in others, there is considerable disparity in the size of the various organizations. Design of your organizational 
chart is made more difficult if the there is a great deal of variation from department to department.  

Organizational charts can list both titles and names of specific personnel. In a large organization, they may simply list 
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the title with the number of people assigned to that title in that department. For example, under computer department, 
you might see the following functions: Software Engineers (25), System Administrator (2), Computer Support 
Specialist (12). If names are required, they can be listed separately by department and function.  

Organizational Chart Examples  

The follow images was create with the Edraw org chart software. You can find more examples in the example gallery.  

  

 

City Organizational Chart  Market Organizational Chart  IT Organizational Chart  

 

 

WEEK   10  Practicals 

 

The student is given a small organizational problem and is required to draw a chart for it. 

Problem: 

Let's make a sample organizational chart for a small organization. Let's imagine a small manufacturing company, 
Kaduna Rubber Shoes ( KRS) for the Coordination Challenged. KRC has twenty-five people on its staff.  

At the top of KRS’s hierarchy are the President and Chief Operation Officer. The president has an Administrative 
Assistant who reports only to him. Place a box to one side of the President's box, but make it smaller than that of the 
President. On a piece of paper or on your computer screen laid out horizontally (landscape) place a box with his/her 
title, followed by his/her name or the number one. Two vice president report to the president. Add two boxes for Vice 
Presidents under the President's box and label them "VP of Operations" and "VP of Sales and Marketing, 
respectively." Production, Quality Control, Shipping, and Receiving report to the VP of Operations. Place a box for 
each of these departments under the box for VP of Operations. As you might guess, the Sales and Marketing 
departments report to the VP of Sales and Marketing. Place the name of the supervisor for each department in its box. 
Note that the Shipping and Receiving, although separate departments with discrete functions, have the same 
supervisor. Show his/or her name in both boxes. Create a small box for each staff member in each of the departments, 
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and list his or her name in the box with his/her title. Connect the boxes with lines to show the relationships and to 
complete the "tree branches".  

We've forgotten one person, the company Accountant, who reports to both the President (for accounts payable and 
receivable) and to the VP of Operations (for purchasing and inventory). Place the accountant's box between the 
President and VP of Operations and connect him/her to each with a dotted line. Dotted lines are used to show dual 
reporting structures within an organization. For example, a person may be assigned full-time to a specific department, 
but have a "dotted line" relationship with another department or organization.  

The process is similar for a large organization, but names are not listed on the chart. However, each title will likely 
show a head count next to the title. Also, any vacancies are specified on the chart.  

A very small organization will likely fit on one piece of paper. Other organizations will require oversize (8.5" x 14" 
or 11" x 17"). To create or print an organizational chart on standard 8.5" x 11" letter size paper, the chart will need to 
be broken into discrete units, usually divisions (groups of departments) or departments. Typically, the executive 
positions are listed on the first page of a multi-page chart. Pages should be numbered and the charts should be 
annotated, similar to the annotation in a map book, to show the chart to which a section connects.  

Finally, you can use box size, line weight, and color to show relationships and to make your chart easier to read. The 
organizational chart is a tool used by both management and staff to document and better understand relationships and 

functional roles within and organization.  

 
 
 
 

 

 

 

WEEK 11 Practicals 

 

We introduce the student this week to other types of diagram that can be encountered in 
system analysis and design 

 

 How to Create a Network Diagram 

Basic Network Diagram  
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Basic network diagrams show the primary pieces of your network and how those pieces are 
connected. This article describes how to quickly create a basic network diagram in Edraw Max. 
If you have Edraw installed, you can create a more detailed network diagram by using the 
Detailed Network Diagram template. The difference between the basic and detailed network 
diagram templates is that the Detailed Network Diagram template comes with more network 
symbols. 

Create a Basic Network Diagram 

Open Edraw. When Edraw opens, all you need to work with is the one titled Template 
Categories. (Tips: If you already have Edraw open, on the Edraw Main Button, point to New, 
and then click Choose Drawing Types....)  

In the Template Categories list, click the Network Diagram category. All of the libraries in the 
network diagram category appear in the central window.  

 

Double-click the template titled Basic Network Diagram.  

When the network diagram shapes library opens, most of the space is taken up with a blank 
drawing page. Because it is important to line up the shapes when you create a diagram, the page 
appears with grid lines on it.  
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Connect Network Diagram Shapes with the Smart Connector 

It's easy to connect organizational chart shapes in Edraw.  

On the Home tab, in the Basic Tools group, click the Connector tool. 

To create a smart connector you need to point the cursor at any connection point of the shape. 
The connection point will be highlighted red. 

 

Network Diagram Examples 
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The follow images was create with the Edraw network diagram software. You can find more 
examples in the example gallery. The following illustration shows some basic network diagrams.  
 

 

Home Network Diagram Cisco Network Design Network Topologies 

Create a detailed network diagram 

Creating a detailed network diagram with Edraw is an effective way to design and document a 
computer network, as in the following illustration.  

Using the Detailed Network Diagram template and the data Link features, you can create a 
diagram that shows how equipment is logically or physically connected, add initial data to 
identify each shape, and then import and link external data to your network shapes. 
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Network Diagram Examples 

How to make an network topology? How indeed does one go about it, without seeing and 

examples of Network Diagram? Unless one has good Network Diagram examples this may 

appear difficult .  

We recommend a new network diagram software similar to Visio, Support flowcharts, 

organizational charts, business charts, UML diagrams, database & ERD, directional map and 

network diagrams. Easy-to-use drawing tools, many pre-drawn flowchart templates, more than 

2000 symbols and examples, create network diagrams and business diagrams with minimum 

time loss.  

With Edraw Max, you can create clear and comprehensive network diagrams with no prior 

experience. As you can see by studying the examples of network diagram below, these types of 

diagrams are the ideal way to illustrate the network design idea and network relativity.  

Diagram a network, draw Computer Network Diagrams, Designs, Schematics, Network Maps 

with our network diagram tool - Edraw Max in a couple of minutes! Pre-drawn network shapes 

representing computers, network devices plus smart connectors help design diagram network, 

create accurate network diagrams and documentation to be used in your network diagram 

project.  

Perfect Network Diagram Examples  

   

Network Diagram Cisco Network Diagram Cisco Topology 
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Lab Network Home Network Diagram Ethernet LAN Diagram 

   

Campus Network Diagram Microwave Topology Network Planform 

   

Security Network Outlook Web Access WAN Diagram 

  

 

Mobile Network Wireless Network Active Directory 
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WEEK  12  Practicals 

More System Analysis Diagrams are introduced 

 

Business Diagram Templates Study each diagram to understand its applications. 
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Edraw is the diagramming tool of choice for business and technical professionals who need to 
quickly and easily visualize, explore, and communicate information. . You can create a wide 
range of diagrams such as business process diagrams, work flow diagrams, value stream maps, 
TQM diagrams, and cause and effect diagrams is a snap.  
 

Easily diagram complex processes that conform to particular standards such as Lean or Six 
Sigma can be obtained. It includes a variety of business process shapes so your diagrams look 
exactly the way you want. Easily collaborate with colleagues to create detailed process diagrams 
and use them as a key element in streamlining your processes.  

 Business Diagram Suite is the most powerful business and relational charting/diagramming 
package available. You may need to create advanced, completely customizable Flow Charts, 
Organizational charts and other relational diagrams from your data.   

Examples of functionality that  business Diagram is perfectly suited for include:  

1. Creating Dynamic Organizational Charts  
2. Creating Social Network Diagrams  
3. Building Flow Charts and Block Charts  
4. Diagramming your business processes  
5. Decision Charts  
6. Much more.  

 

 

 



 

Business Diagram Examples  

 

What are the Benefits of Business Diagram

1. Gain greater understanding of your corporate data, by visualizing business processes and 
acting on them.  

2. Dynamically create advanced, customized Organizational Charts and Diagrams on the 
web.  

3. Visually examine how people, business functions and other items relate to each other. 
4. Create custom, reusable objects for rapid application development. 
5. With just a few clicks, Edraw can connect, align, and evenly distribute shapes in your 

business process diagrams. Edraw can automatically connect shapes as you drag, drop, 
and rearrange them onto the drawing page, or connect existing shapes that are already on 
the drawing page.  

Works in the following fields  

• Basic Flowchart, Data Flowchart

• Business Chart, Audit Flow Diagrams
Analysis, TQM Diagram.  

• Organizational chart.  

• Human Resource Diagram  

• Workflow Diagram   

• 2D, 3D Shapes, Arrow and Connector lines, Annotations, Borders and Titles, Background. 

• Network Design Diagram.  

                       

 

 

 

What are the Benefits of Business Diagram 

Gain greater understanding of your corporate data, by visualizing business processes and 

Dynamically create advanced, customized Organizational Charts and Diagrams on the 

Visually examine how people, business functions and other items relate to each other. 
Create custom, reusable objects for rapid application development.  

ew clicks, Edraw can connect, align, and evenly distribute shapes in your 
business process diagrams. Edraw can automatically connect shapes as you drag, drop, 
and rearrange them onto the drawing page, or connect existing shapes that are already on 

 

Data Flowchart, IDEF0 Flowchart, SWOT Diagram and SDL Diagram

Audit Flow Diagrams Cause and Effect Diagram, EPC Diagram

2D, 3D Shapes, Arrow and Connector lines, Annotations, Borders and Titles, Background. 
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Gain greater understanding of your corporate data, by visualizing business processes and 

Dynamically create advanced, customized Organizational Charts and Diagrams on the 

Visually examine how people, business functions and other items relate to each other.  

ew clicks, Edraw can connect, align, and evenly distribute shapes in your 
business process diagrams. Edraw can automatically connect shapes as you drag, drop, 
and rearrange them onto the drawing page, or connect existing shapes that are already on 

SDL Diagram.  

EPC Diagram, Fault Tree 

2D, 3D Shapes, Arrow and Connector lines, Annotations, Borders and Titles, Background.  
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WEEK   13  - 14    Practicals 

Business Process Drawings 

Build-in Shapes for Draw Process 

Only drag these lists to your drawing and it's easy to change the theme color and style.  

 

Process List 
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Use to show multiple groups of information or steps and sub-steps in a task, process, or 
workflow. Level 1 text corresponds to the top horizontal shapes, and Level 2 text corresponds to 
vertical sub-steps under each related top-level shape.  

Accent Process 

 

Use to show a progression, a timeline, or sequential steps in a task, process, or workflow. Works 
well for illustrating both Level 1 and Level 2 text.  

Basic Bending Process 

Use to show a progression or sequential steps in a task, process, or workflow. Maximizes both 
horizontal and vertical display space for shapes.  

Basic Chevron Process 

Use to show a progression; a timeline; sequential steps in a task, process, or workflow; or to 
emphasize movement or direction. Level 1 text appears inside an arrow shape while Level 2 text 
appears below the arrow shapes.  

Basic Process 

Use to show a progression or sequential steps in a task, process, or workflow.  

Circular Bending Process 

Use to show a long or non-linear sequence or steps in a task, process, or workflow. Works best 
with Level 1 text only. Maximizes both horizontal and vertical display space for shapes.  

Closed Chevron Process 

Use to show a progression, a timeline, or sequential steps in a task, process, or workflow, or to 
emphasize movement or direction. Can be used to emphasize information in the starting shape. 
Works best with Level 1 text only.  

Continuous Arrow Process 

Use to show a timeline or sequential steps in a task, process, or workflow. Works best with Level 
1 text because each line of Level 1 text appears inside the arrow shape. Level 2 text appears 
outside the arrow shape.  
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Continuous Block Process 

Use to show a progression or sequential steps in a task, process, or workflow. Works best with 
minimal Level 1 and Level 2 text.  

Detailed Process 

Use with large amounts of Level 2 text to show a progression through stages.  

Process Arrows 

Use to show information illustrating a process or workflow. Level 1 text appears in the circular 
shapes and Level 2 text appears in the arrow shapes. Works best for minimal text and to 
emphasize movement or direction.  

 

Ribbon Arrow 

 

Use to show either related or contrasting concepts with some connection, such as opposing 
forces. The first two lines of Level 1 text are used for text in the arrows. Unused text does not 
appear, but remains available if you switch layouts.  

Repeating Bending Process  

Use to show a progression or sequential steps in a task, process, or workflow. Maximizes both 
horizontal and vertical display space for shapes.  

Segmented Process 

Use to show a progression or sequential steps in a task, process, or workflow. Emphasizes Level 
2 text, since each line appears in a separate shape.  

Staggered Process 
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Use to show a downward progression through stages. Each of the first five lines of Level 1 text 
corresponds with a rectangle. Unused text does not appear, but remains available if you switch 
layouts.  

Upward Arrow 

 

Use to show a progression or steps that trend upward in a task, process, or workflow. Each of the 
first five lines of Level 1 text corresponds to a point on the arrow. Works best with minimal text. 
Unused text does not appear, but remains available if you switch layouts.  

 

Vertical Bending Process 

Use to show a progression or sequential steps in a task, process, or workflow. Maximizes both 
horizontal and vertical display space for shapes. Places more emphasis on the interrelationships 
among the shapes than on direction or movement.  

Cycle Diagram  
Edraw Max contains some symbols for designers to draw the cycle diagrams. Find the symbols 
in the List, Process, Charts and Graphics library.  

Basic Cycle Diagram 

Use to represent a continuing sequence of stages, tasks, or events in a circular flow. Emphasizes 
the stages or steps rather than the connecting arrows or flow. Works best with Level 1 text only.  

Basic Pie Diagram 
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Use to show how individual parts form a whole. The first seven lines of Level 1 text correspond 
to the evenly distributed wedge or pie shapes. The top Level 1 text shape appears outside of the 
rest of the pie for emphasis. Unused text does not appear, but remains available if you switch 
layouts.  

Basic Radial Diagram 

Use to show the relationship to a central idea in a cycle. The first line of Level 1 text corresponds 
to the central shape, and its Level 2 text corresponds to the surrounding circular shapes. Unused 

text does not appear, but remains available if you switch layouts.  

Block Cycle Diagram 

 

Use to represent a continuing sequence of stages, tasks, or events in a circular flow. Emphasizes 
the stages or steps rather than the connecting arrows or flow.  

Continuous Cycle 

Use to represent a continuing sequence of stages, tasks, or events in a circular flow. Emphasizes 
the connection between all components. Works best with Level 1 text only.  

Cycle Matrix 

Use to show the relationship to a central idea in a cyclical progression. Each of the first four lines 
of Level 1 text corresponds to a wedge or pie shape, and Level 2 text appears in a rectangular 
shape to the side of the wedge or pie shape. Unused text does not appear, but remains available if 
you switch layouts.  
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Diverging Radial Diagram 

Use to show relationships to a central idea in a cycle. The first Level 1 line of text corresponds to 
the central circular shape. Emphasizes the surrounding circles rather than the central idea. 
Unused text does not appear, but remains available if you switch layouts.  

Gear Diagram 

 

Use to show interlocking ideas. Each of the first three lines of Level 1 text corresponds to a gear 
shape, and their corresponding Level 2 text appears in rectangles next to the gear shape. Unused 
text does not appear, but remains available if you switch layouts.  

Multidirectional Cycle Diagram 

Use to represent a continuing sequence of stages, tasks, or events that can occur in any direction.  

Radial Cycle Diagram 

Use to show the relationship to a central idea. Emphasizes both information in the center circle 
and how information in the outer ring of circles contributes to the central idea. The first Level 1 
line of text corresponds to the central circle, and its Level 2 text corresponds to the outer ring of 
circles. Unused text does not appear, but remains available if you switch layouts.  

Radial Venn 
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Use to show both overlapping relationships and the relationship to a central idea in a cycle. The 
first line of Level 1 text corresponds to the central shape and the lines of Level 2 text correspond 
to the surrounding circular shapes. Unused text does not appear, but remains available if you 
switch layouts.  

Segmented Cycle Diagram 

Use to show a progression or a sequence of stages, tasks, or events in a circular flow. 
Emphasizes the interconnected pieces. Each of the first seven lines of Level 1 text corresponds to 
a wedge or pie shape. Unused text does not appear, but remains available if you switch layouts.  

Text Cycle Diagram 

 

Use to represent a continuing sequence of stages, tasks, or events in a circular flow. Emphasizes 
the arrows or flow rather than the stages or steps. Works best with Level 1 text only.  
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WEEK   15  Practicals 

The student is expected here to familiarize himself with designing and drawing diagrams of 
Database models, Marketing models,  

Database Model Diagrams  

Draw database model diagrams  

You can  easily use an intuitive database design tool and database model Diagram tool which can 
save you hundreds hours of work.  

This tool will  allows you to reverse engineer already existing database structures, create detailed 
HTML or PDF reports.  

 

The Entity-Relationship Model  

The Entity-Relationship (ER) model was originally proposed by Peter in 1976 [Chen76] as a way 
to unify the network and relational database views. Simply stated the ER model is a conceptual 
data model that views the real world as entities and relationships. A basic component of the 
model is the Entity-Relationship diagram which is used to visually represents data objects. Since 
Chen wrote his paper the model has been extended and today it is commonly used for database 
design For the database designer, the utility of the ER model is:  

• it maps well to the relational model. The constructs used in the ER model can easily be 
transformed into relational tables.  

• it is simple and easy to understand with a minimum of training. Therefore, the model can 
be used by the database designer to communicate the design to the end user.  

• In addition, the model can be used as a design plan by the database developer to 
implement a data model in a specific database management software.  

Symbols for Database Model Diagrams  

Thanks to an extensive set of library objects such as entities, links, items, attributes, users, types, 
captions, inheritance, references, boundaries, events, clouds etc Edraw is a perfect tool for 
database model design and ER diagramming.  
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You can  draw Chen ERD, Database model diagram, Express-G, Martin ERD, ORM Diagram 
and a lot more.  

 

 

 

Basic Constructs of E-R Modeling  

The ER model views the real world as a construct of entities and association between entities.  

Entities  

Entities are the principal data object about which information is to be collected. Entities are 
usually recognizable concepts, either concrete or abstract, such as person, places, things, or 
events which have relevance to the database. Some specific examples of entities are 
EMPLOYEES, PROJECTS, INVOICES. An entity is analogous to a table in the relational 
model.  

Entities are classified as independent or dependent (in some methodologies, the terms used are 
strong and weak, respectively). An independent entity is one that does not rely on another for 
identification. A dependent entity is one that relies on another for identification.  

An entity occurrence (also called an instance) is an individual occurrence of an entity. An 
occurrence is analogous to a row in the relational table.  
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Special Entity Types  

Associative entities (also known as intersection entities) are entities used to associate two or 
more entities in order to reconcile a many-to-many relationship.  

Subtypes entities are used in generalization hierarchies to represent a subset of instances of their 
parent entity, called the supertype, but which have attributes or relationships that apply only to 
the subset.  

Associative entities and generalization hierarchies are discussed in more detail below.  
 
Relationships  

A Relationship represents an association between two or more entities. An example of a 
relationship would be:  

1. employees are assigned to projects  
2. projects have subtasks  
3. departments manage one or more projects  

Relationships are classified in terms of degree, connectivity, cardinality, and existence. These 
concepts will be discussed below.  
 
Attributes  

Attributes describe the entity of which they are associated. A particular instance of an attribute is 
a value. For example, "Jane R. Hathaway" is one value of the attribute Name. The domainof an 
attribute is the collection of all possible values an attribute can have. The domain of Name is a 
character string.  

Attributes can be classified as identifiers or descriptors. Identifiers, more commonly called keys, 
uniquely identify an instance of an entity. A descriptor describes a non-unique characteristic of 
an entity instance.  

Classifying Relationships  

Relationships are classified by their degree, connectivity, cardinality, direction, type, and 
existence. Not all modeling methodologies use all these classifications.  

Degree of a Relationship  

The degree of a relationship is the number of entities associated with the relationship. The n-ary 
relationship is the general form for degree n. Special cases are the binary, and ternary ,where the 
degree is 2, and 3, respectively.  
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Binary relationships, the association between two entities is the most common type in the real 
world. A recursive binary relationship occurs when an entity is related to itself. An example 
might be "some employees are married to other employees".  

A ternary relationship involves three entities and is used when a binary relationship is 
inadequate. Many modeling approaches recognize only binary relationships. Ternary or n-ary 
relationships are decomposed into two or more binary relationships.  
 
Direction  

The direction of a relationship indicates the originating entity of a binary relationship. The entity 
from which a relationship originates is the parent entity; the entity where the relationship 
terminates is the child entity.  

The direction of a relationship is determined by its connectivity. In a one-to-one relationship the 
direction is from the independent entity to a dependent entity. If both entities are independent, 
the direction is arbitrary. With one-to-many relationships, the entity occurring once is the parent. 
The direction of many-to-many relationships is arbitrary.  

 

Type  

An identifying relationship is one in which one of the child entities is also a dependent entity. A 
non-identifying relationship is one in which both entities are independent.  

Existence  

Existence denotes whether the existence of an entity instance is dependent upon the existence of 
another, related, entity instance. The existence of an entity in a relationship is defined as either 
mandatory or optional. If an instance of an entity must always occur for an entity to be included 
in a relationship, then it is mandatory. An example of mandatory existence is the statement 
"every project must be managed by a single department". If the instance of the entity is not 
required, it is optional. An example of optional existence is the statement, "employees may be 
assigned to work on projects".  

Generalization Hierarchies  

A generalization hierarchy is a form of abstraction that specifies that two or more entities that 
share common attributes can be generalized into a higher level entity type called a supertype or 
generic entity. The lower-level of entities become the subtype, or categories, to the super type. 
Subtypes are dependent entities.  

ER Notation  
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There is no standard for representing data objects in ER diagrams. Each modeling methodology 
uses its own notation. The original notation used by Chen is widely used in academics texts and 
journals but rarely seen in either CASE tools or publications by non-academics. Today, there are 
a number of notations used, among the more common are Bachman, crow's foot, and IDEFIX.  

All notational styles represent entities as rectangular boxes and relationships as lines connecting 
boxes. Each style uses a special set of symbols to represent the cardinality of a connection. The 
notation used in this document is from Martin. The symbols used for the basic ER constructs are:  

• entities are represented by labeled rectangles. The label is the name of the entity. Entity 
names should be singular nouns.  

• relationships are represented by a solid line connecting two entities. The name of the 
relationship is written above the line. Relationship names should be verbs.  

• attributes, when included, are listed inside the entity rectangle. Attributes which are 
identifiers are underlined. Attribute names should be singular nouns.  

• cardinality of many is represented by a line ending in a crow's foot. If the crow's foot is 
omitted, the cardinality is one.  

• existence is represented by placing a circle or a perpendicular bar on the line. Mandatory 
existence is shown by the bar (looks like a 1) next to the entity for an instance is required. 

Optional existence is shown by placing a circle next to the entity that is optional. 

Draw Marketing Charts and Diagrams  

Edraw Max is a vector-based diagramming software with rich 

examples and templates. Easy to create flow charts, 

organizational charts, business process, UML diagrams, work 

flows, program structures, network diagrams, chart and 

graphics, mind map, directional maps and database diagrams. 

With pre-drawn libraries and more than 4600 vector symbols, 

drawing couldn't be easier!  

   Symbols for Marketing Charts and Diagrams  

Marketing Shapes  
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Marketing Diagrams  

 

Some symbols has the control points and you can move them to change the shape's appearance.  
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